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Experiment 1  
 Introduction to Data Analysis Using EXCEL 

 
 
I.  Purpose             
 
  The purpose of this lab is to teach you a few basic things about using EXCEL 2016 to plot 
data, analyze results and work out answers to the pre-lab assignments. If you have somehow 
managed to get this far without learning how to use a spreadsheet, now is a good time to start to 
learn, especially since you will need to use it all semester for homework and labs.  
 Section VI is a general introduction to spreadsheets and then discusses how to use EXCEL 
2016 for some basic tasks as well as some more advanced features. You need to read through this 
before you get to the lab. If you have not used EXCEL before, or are not familiar with some feature 
in EXCEL, start-up a spreadsheet and work along as you read through the write-up. Section VII 
has some useful shortcuts that make it easier to work with the spreadsheet. 
 The final part of this lab, Section VIII, is an exercise that takes you through many of the 
spreadsheet operations that are used in the labs. Everyone must complete Part VII and turn in a 
copy of his or her spreadsheet to ELMS Canvas before it is due to get credit for this lab.  
 
II. Preparing for the Lab         
 You need to prepare before going to the lab and trying to do this experiment. Start by 
reading through this lab write-up before you get to the lab. The Introduction Sections VI and VII 
are long - you need to read them before you get to the lab. For a video introduction to Excel by 
Jordan Goodman, we recommend https://youtu.be/ZVkrjrDKMZw . Finally, don’t forget to do the 
Pre-Lab questions and turn them in to Expert TA before your lab starts.  
 
III.  References            
   If you are not already comfortable with using EXCEL and need more detail than found in 
this write-up, try clicking on Excel’s Help button.  
 
IV.  Equipment            
   You will need a copy of Excel Template for Lab 1 and a computer with Excel running 
Windows 10. Note: the lab templates may not work with older versions of Excel.  
 
V. Pre-lab Questions  (Submit answers to Expert TA before your lab section meets) 
Questions and multiple choice answers on Expert TA may vary from those given below. Be sure 

to read questions and choices carefully before submitting your answers on Expert TA. 
 

#1. A cell in an EXCEL spreadsheet contains $A$5. What does it mean? (pick one) 
      (a) Cell A5 is formatted as a currency. (b) Cell A5 is a fixed cell. (c) This tells Excel that cell 

A5 is text rather than a numerical input. (d) This means the cell contains a formula. (e) This is 
EXCEL’s way to indicate the cell contains an error. 

#2. Given an x-coordinate and a y-coordinate for a point, which type of chart in EXCEL will 
actually plot the point at its Cartesian coordinates? (pick the best answer) (a) line chart, (b) pie 
chart, (c) scatter chart, (d) bar chart, (e) all of the others except the pie chart. 

https://youtu.be/ZVkrjrDKMZw
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#3. In EXCEL, what is the Solver used for? (pick the best answer)  
     (a) Finding errors in a formula, (b) minimizing or maximizing a cell by varying other cells, (c) 

doing error analysis, (d) solving algebraic equations, (e) solving differential equations.  
#4. To run a macro in EXCEL, you may need to first click on.....?  (pick the best answer)  
      (a) a cell and type in the macro formula, (b) the home tab and then click on the paste button, 

(c) the insert tab and then enter your macro into a cell, (d) the view tab and then click on the 
macro button. 

#5. Before the lab template will let you exit from EXCEL, you must have (a) entered your name 
in the designated area of the spreadsheet, (b) entered your section number in the designated 
area of the spreadsheet, (c) saved the file using the gray save button in the body of the 
spreadsheet, (d) all of the above. 

 
VI. Introduction             
 
Spreadsheets 
 A spreadsheet is a computer program that makes your computer display act like a smart 
piece of paper. It removes much of the grunt work associated with repetitive calculations and lets 
you easily see the results of your work. Traditionally accountants used spreadsheets to do 
bookkeeping and budgets, but they make outstanding tools for scientists as well. In the physics 
labs, using a spreadsheet reduces the amount of time it takes you to plot and analyze data. In 
particular, you can enter raw data, manipulate it and plot it with a few simple commands.   
 One thing that makes an electronic spreadsheet much more powerful than a calculator or a 
paper spreadsheet is that every time you change a number or formula in your spreadsheet, 
everything else in the spreadsheet gets automatically recalculated, including plots.  So if you 
make a mistake and have to re-measure a quantity, or change a formula, all numbers connected to 
it are automatically updated. Another thing that makes a spreadsheet powerful is that everything 
is displayed in an intuitive graphical interface (the spreadsheet). With everything displayed, it is 
easier to understand your data and spot problems.   
 Yet another reason spreadsheets are extremely useful for data analysis is because of their 
ability to plot data.  Rather than having to draw a graph by hand, you can just select the numbers 
you want to plot and let the spreadsheet do the work. Even better, if you change the numbers or 
formulas, the graph changes automatically. If you want to copy a plot, you can make as many as 
you want and paste them into MS Word files or PowerPoint slides. Still another advantage of a 
spreadsheet is that it can easily handle the statistical analysis of data sets with hundreds, 
thousands, or even tens of thousands of points, something that you would never want to try doing 
on a calculator. Some examples of functions that are particularly useful in analyzing data are the 
average, the standard deviation and a least square fit of a straight line (known as a linear 
regression) to find the slope and the intercept. 
 Given the many advantages of using a spreadsheet, you should never use a calculator in 
any of the labs because it is poorly suited to the job of recording, plotting, analyzing and saving 
data. Of course, spreadsheets do have some significant limitations. They are not good for working 
with data sets that are very large, or that require symbolic manipulation, or that involve extensive 
signal analysis, sophisticated physical modeling, or custom image processing, are best handled 
using more sophisticated programs or custom written software routines. 
 
Cells, Rows and Columns 
 A spreadsheet display consists of a collection of cells arranged in a table. The cells are 
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labeled by their column and row location (see Table 1 below).  For example cell B3 is in the second 
column, the third cell down.  A cell can contain text, a number, a formula, or a logical value 
(true/false). To enter something into a cell, click on it with the mouse, type in some text, and then 
hit enter. The spreadsheet will display the text in the cell (see cell A1 or cell C1 below in Table 1). 
You can also enter numbers like 15 (see cell A2) and formulas (see cells A2 and A3).  Cell B1 
contains a simple formula that is, of course, equal to 6. In Excel, all formulas begin with an equals 
sign. If you type this formula into cell B1 and then hit enter, you will see that the spreadsheet now 
displays the number 6 instead of the formula =3*2 (see Table 2).  
 The formula in cell B2 shows a different example. It says =2*A2. What this means is twice 
the value of the cell A2.  Since A2 is currently 15, B2 displays the value 30 (see Table 0.2). If the 
number 15 in cell A2 is changed to 20, then the spreadsheet will immediately recalculate 
everything and cell B2 would get changed to 40. This way of setting up formulas, with parameters 
being displayed in other cells, is very useful because it makes it easier to find and correct mistakes. 
 So if a cell has a formula in it, and EXCEL displays this as a number, what do you do if 
you want to see the formula and not the number? If you want to check a formula or change a 
formula, you need to see it. The best way to get EXCEL to display a formula in a cell, rather than 
the result produced by the formula, is to double-click on the cell. When you double-click on a cell, 
EXCEL not only shows you the formula in the cell but also highlights any cells that the formula 
is using. This simple feature turns out to be especially powerful for helping you find mistakes in 
a formula. 
 Another really convenient feature of spreadsheets is the ability to replicate formulas.  As 
an example, suppose that you wanted to extend the above spreadsheet so that the numbers go from 
15 and 16 all the way to 25.  Of course you could type 17, 18, … into cells A4, A5 etc., but this is 
unnecessary.  Instead, you can use the copy and paste tools to replicate the formula in cell A3 to     
  
 
Table 1- This shows what to put in various cells in the spreadsheet. 
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Table 2- This shows what the spreadsheet displays. 
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the cells A4 to A12. Cell A3 has the formula =A2+1 in it.  Now what you would like in cell A4 is 
not exactly the same formula as A3, but you would like it to say A3+1 (not A2+1).  This way it 
will become 17. When you copy and paste a formula, the formula is automatically changed in just 
this way. For example, if you copy the formula A3 and paste it into cells A4 through A12, the 
formulas will become =A3+1, =A4+1, =A5+1 etc. all the way to A11+1.  If you were to copy the 
formula in B2 and paste it into C2, it would change in a similar manner.  It would change from 
=2*A2 to =2* B2, and in your example the value would become 2*(2*15) or 60. You rarely have 
to type a formula more than once, even if it is used frequently. Also if you have a column of 
formulas and you want to change, you can change one cell and copy it to all the others.    
 Sometimes you will want to copy a formula, or move it from one place to another, without 
having it change. There are a several ways to do this in Excel. The simplest way is to use cut and 
paste instead of copy and paste. For another way, see the discussion of the $ symbol below.  
 
Excel 2016 

If you are not already familiar with Excel 2016 in Windows 2010, open up a worksheet 
and try using all the commands as you go through this section at home on your own computer. We 
also recommend viewing https://youtu.be/ZVkrjrDKMZw which is Jordan Goodman’s video 
introduction to Excel. On the other hand, if you are familiar with Excel, you can skip this section, 
but make sure you read through the Section VII on Excel Shortcuts & Tools. 

 
1. Opening and Saving Files 

You can open an Excel spreadsheet by clicking on the Excel icon on the desktop and 
selecting Blank Workbook. After the spreadsheet opens, click on the Save button on the left top 
side of the menu bar and then enter a file (make sure your name is in the file so you can find it). 
Excel will save the file in the Documents folder - our desktop setup prevents you from saving files 
in other folders. You should try to remember to regularly resave your files! 

  
2. Moving around the spreadsheet 

You can move from cell to cell by using your mouse, the cursor keys, or by using the PgUp 
and PgDn keys. There are also sliding scales on the right side and bottom of the worksheet which 
you can move with the mouse to move around the worksheet. You can also go directly to a specific 
cell by pressing the F5 key and entering the cell address. The cell addresses in Excel are in the 
form “C23” or "sheet1:C23", which is cell C23 on sheet1.  

Excel also lets you have many worksheets in the same “notebook”. The tabs on the bottom 
of the worksheet let you switch from sheet to sheet.  
 
3. Entering Information 

To put information into a cell, click on the cell or move the cursor to that cell and type in 
the information. The characters that you type will appear on the top left of the page on the third 
line (called the display line). Press the Enter button after typing something and it will enter it into 
the sheet. If you press the Esc key it will abort the entry and leave the cell unchanged. To enter an 
expression in a cell, you can type in the cell or you can move the cursor to the display line at the 
bottom of the menu bar and edit the expression there. 
 
4. Entering Numbers and Text Into a Cell 

Numbers are entered by into a cell by simply clicking on a cell and typing a number. Try 

https://youtu.be/ZVkrjrDKMZw
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typing the number 15 in the cell B7.  If the number is negative just start it with a minus sign.  
Putting labels on your data lets you make your spreadsheet readable to you and to others.  

While there are some limitations (such as it is clumsy to get Greek letters), it is easy to add text to 
a spreadsheet. If you just type words into a cell they will show up in that cell.  For example try 
typing your first and last name into cell A1. Actually, that is a good thing to do with all of your 
spreadsheets. If the text is longer than the cell width (which is adjustable) the whole text will show 
up if there are empty cells to the right of the cell with the text in it.  If the string is long and the 
cell next to it is occupied the string will show up cut off, but it is all still there. You can adjust the 
width a column by clicking on the markers that separate the columns at the top of the worksheet 
(ask your instructor if you are not sure how to do this). 
 
5. Entering Formulas 

For a short video by Jordan Goodman on using formulas in Excel, see 
https://youtu.be/caQGqjFo3xY. Formulas are indicated by starting with = (an equal sign). For 
example, if you type =2*3 into a cell and hit enter, it will display 6 in the cell. If you click on the 
cell, it will show you the formula in the cell and on the display line. Formulas can be much more 
complicated expressions, involving other cells and statistical and mathematical functions. A 
formula like =2*B5^3 means 2 times the contents of cell B5 raised to the third power. You can 
use parenthesis in a natural way, for example =1/((1/B3)^2+(1/B4)^2)^(1/2).  The spreadsheet has 
functions such as sine and cosine. For example, to find the sine of the angle π/2, you would type 
=sin(pi()/2) into a cell. Note that Excel takes angles in radians, not in degrees. Also π in Excel is 
written as =pi() which is a function with no argument. If you type =sin(C3) this will take the Sine 
of the contents of cell C3.  To find the cosine of the angle π/2, you would type =cos(pi()/2).    
 Excel has many familiar functions as well as many special functions that you are only likely 
to encounter in more advanced math, physics or statistics classes. Some examples of common 
spreadsheet functions are: 

 =average(…)  =stdev(…)  =count(…)  =sum(…) 
  =max(…)  =min(…)  =sqrt(…)  =slope(…) 
  =intercept(….)  =exp(…)  =pi()   =cos(…) 

 =sin(…)  =tan(…)  =atan(…)   
The list of available functions can be viewed by clicking on the function button fx on the 

menu bar at the top of the worksheet and choosing “all”. If you want a description of the function, 
click on its name.  A description will appear at the bottom of the function box.  Function names in 
Excel are not sensitive to case. You can type =COS or =Cos or =cOs.   

 Some functions take lists of numbers or a range of cells. For example, =Average(5,6,7,8) 
will return the value 6.5. The formula =Average(A1:A20) will find the average of the values in 
all the cells from A1 to A20. The colon between A1 and A20 is Excel's way of saying A1 to A20, 
inclusive. If you used a comma instead to separate the A1 and the A20, it would just find the 
average of the numbers stored in A1 and A20. Most spreadsheet functions are “smart”; if your 
range includes empty cells they are not counted in the average or other statistical function, but if 
there is a zero, it will be included. Note: there is a distinction between empty and zero. 

 
6. Pointing at Cells 

When you first start using a spreadsheet, you may waste a lot of time typing cell numbers 
into equations and expressions and you will make many mistakes. A much better way to put a cell 
number into an expression is to point at it or click on it. For example, suppose you have recorded 

https://youtu.be/caQGqjFo3xY
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the value of an angle θ in Cell A10 and now want to find the cosine of θ. You can go to cell A11 
and simply type =cos(  then use the mouse to move the cursor to cell A10 and click on the cell.  At 
this point your expression will read =cos(A10. Now just type in the closing parenthesis), which 
will give you =cos(A10), and hit enter. 

 
7. Selecting Ranges 

You can also select or point at groups of cells. This is useful for expressions such as the 
average or standard deviation that expect ranges as arguments.  It is also useful when you want to 
mark a region that needs to be moved or copied.  If you need a range of cells, use the mouse to 
move the cursor to the first cell in the range and hold the left mouse button.  Now “drag” the cursor 
to the last cell in the range and release the button.  You should now have the range highlighted and 
displayed in the display line.  

 
8. Copying a formula 

EXCEL allows you to copy the contents of one cell to another. However, it is a “smart 
copy”, and will often change the contents during the copy.  Most of the time you will find this is 
an extremely useful feature, as you will see below, but whenever you do a copy using EXCEL, be 
sure to check and make it did what you wanted! 
To see how the smart copy works, suppose you have 20 
numbers in cells A1:A20 and you want to find the Sine of 
these numbers (see Figure 1). To do this, enter in cell B1 
the formula =sin(A1). Now that you have the formula in 
one cell, there are several ways to copy it to cells B2:B20, 
including using the Copy button and using Ctrl c. In this 
case you need to copy to cells right below cell B1 and the 
simplest way to do this is to click on cell B1 and notice 
that Excel has not only highlighted cell B1 with a black 
box, but it has also put a small black square in the lower             Figure 1. Clicking on a cell high-  
right corner (see Figure 1). Carefully place your cursor over        lights it and Excel places a   
this little square and then click, hold, and drag the square            small black square in the corner. 
down to cell B20 and this will copy the formula into cells 
B2:B20. Note that in cell B2 that Excel has changed the formula to =sin(A2), and not =sin(A1). 
This means column B has the sine of the values in column A, which is what you want. The way 
that Excel updates the cell names as it copies is what makes Excel’s copy so smart.   

Of course sometimes it will happen that you do not want the cell location to change when 
you copy a formula. This is called making a “fixed cell”. To make a fixed cell in a formula so that 
it doesn’t change when copying, you need to add dollar signs, for example $B$1. There are two 
dollar signs in the expression shown here because it is possible to fix the column and the row or 
both.  If you just wanted to fix the row, you would use B$1.  The “B” would then change according 
to the “smart copy" rules during the copy.  If you just wanted to fix the column, you would use 
$B1.  An example where you might want to use this is: You have a column (A1:A20) of measured 
accelerations "a" and you want a column of forces and all objects have the same mass.  If the mass 
"m" is in cell D1 your formula for the force "F" in B1 might be =$D$1*A1.  This way when you 
copy the formula to B2 it will be =A2*$D$1.  If you didn’t use $ signs, the formula would have 
been $A2*D2 which would be wrong if the mass was in D1. For a short video on fixed cells, see 
https://youtu.be/zjWWIhb4XTs. 
 

https://youtu.be/zjWWIhb4XTs
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9 - Plotting Data 
 The only type of chart you should ever use in Excel is a Scatter chart. Using any other 
type of chart can cause serious mistakes. Although Excel can draw many different types of charts, 
only a Scatter chart will plot an x-value and a y-value as a point at the coordinates (x,y) in the 
Cartesian plane. For example, a Line chart plots the y-values versus the order in which the points 
are given and it does not use the x-values to determine the x-coordinate. To be clear, you should 
only use a Scatter chart and never use any other type of chart in Excel.  
 Typically you will plot one column of numbers (y coordinates) versus the numbers in a 
second column (x coordinates). For example, suppose you want to plot y = sin(x) versus x. To do 
this, you will need to put some x-values into one column and then put the sine of them in a second 
column. Start by entering the label “X (rad)” into cell D1. Next enter 0 into cell D2.  Then in D3 
enter =D2+0.3. Next copy this formula from D2, D3, ... D20.  Next enter the label “y=Sin(X)” into 
cell E1.  Now in E2, enter =SIN(D2).  Copy this formula to cells E2,...E20.   
    To plot this data, go to the top of the spreadsheet and click on the Insert tab (see Figure 
2). Now use your mouse to select cells D1 to D20 and cells E1 to E20 (to select the group of cells 
just click on cell D1, hold the left mouse button down as you drag the mouse to cell E20, and then 
release the mouse button). Then look for the section of the menu at the top of the spreadsheet that 
says Charts and click on Scatter (see the note below about why you should always use Scatter 
plots). You will be presented with a sub-menu of different types of scatter plots (just points, just 
lines, lines and points, etc.), choose any one of these by clicking on it. You should now see a plot 
and notice that the menu at the top of the spreadsheet has changed. Click on the Chart Layout 
menu and try selecting Layout #10, which has a nice format. All of your plots should have labels 
on the x and y-axes. In this case, Layout #10 just has default labels that say “Axis Title”. To change 
the axes labels, just click on them and type in “X (rad)” for the x-  axis label and “y=Sin(x)” for 
the y-axis label. 
 If your plot is covering some cells that you want to see, just click on the chart and you can 
move it to the side with the mouse. Notice that when you click on the chart, Excel will highlight 
columns that are being plotted. This is very useful because a common and confusing mistake is 
to plot the wrong set of numbers. To avoid this mistake, you should get into the habit of clicking 
on your charts and letting EXCEL show you what cells it is using for the plot. 
 
10 - Modifying Charts, Adding Titles and Labels, and Copying charts 
 If you want to change something in a chart, just try right-clicking or left-clicking on it - 
you can change the axis limits, the chart background, the type of chart, the curves being displayed, 
the grid, the tick marks, and the maximum and minimum range being plotted. To change the x-
axis label, the y-axis label or title on a chart, just click on it and type in the new label or title. 
Clicking on one of your points in the chart lets you change the symbols used in the plot, as well as 
their size and color, and the line-width and color of the line in the plot. If you forgot to add an axes 
labels or a chart title, just right click on the chart, then go to the Chart tools area on the menu bar, 
click on the Layout tab and hit the chart title or axis titles buttons. 
 It can takes time to get a chart with the axes properly labelled and everything else looking 
just right. If you have to make another plot of some more data, you could just go through the same 
steps needed to make a plot from scratch. However, there is an easier way. Just click on the plot 
you made (this selects it) and then click on the Copy button on the Home tab. Next click on an 
empty cell and hit the paste button. This creates a copy of your plot. Of course it is plotting the 
same thing as your first plot, but it is very easy to change what is being plotted. Click on one of 
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the data points and EXCEL will highlight the cells that are being plotted by drawing a cyan box 
(x-coordinates) or blue box (y-coordinates) around them. To change what is being plotted on the 
x-axis, just move your mouse over the border of the cyan box, click and hold, and then move your 
mouse until it is over the x-coordinates for the plot that you would like to create - the cyan box 
will follow - release the button when the box is over the coordinates you want to plot. You can 
choose a new set of y-coordinates the same way.  
 
11 - Adding Another Curve to an Existing Plot 
 Suppose you have already made a plot of your data and you want to add a curve for a 
theory. One way to do this is to right click on the plot and then click on Select Data in the pop-
up menu that appears. A new pop-up menu will open and you should click on the Add button. 
Once you do this, another pop-up menu will appear which will allow you to enter a series name 
and select the x and y columns for the second data series. Once you fill these in, just click OK and 
you should see your new plot with both curves. Of course for this to work, you need to have set 
up columns with x and y theory values that you can select. 
 Sometimes you will make a plot and forget to add axes titles. Just click on the chart and 
notice a small menu opens up to the right of the chart. Click on the + symbol in this menu and you 
will see check-boxes for things like the chart title, axis titles, error bars and legend. A new 
menu also appears at the top of the spreadsheet called Chart Tools. Select the Design tab and then 
select Add Chart Element and choose from this menu what you want to add. Another way to add 
axes labels is to click on the chart, select the Design and then pick a chart from one in the Quick 
Layout menu that has axes labels already in them (edit the default titles by clicking on the label 
and typing).  
  
12 - Modifying Charts, Adding Titles and Labels, and Copying charts 
 If you want to change something in a chart, just try clicking on it - you can change the axis 
limits, the chart background, the type of chart, the curves being displayed, the grid, the tick marks, 
the maximum and minimum range being plotted, and the error bars. To change the x-axis label, 
the y-axis label or title on a chart, just click on it and type in the new label or title. Clicking on one 
of your points in the chart lets you change the symbols used in the plot, as well as their size and 
color, and the line-width and color of the line in the plot. If you forgot to add axes labels or a chart 
title, just click on the chart and a small menu will appear to the right of the chart. Click on the + 
symbol in this menu and you will see check-boxes for things like the chart title, axis titles, error 
bars and legend. 
 It can take a fair amount of time to get a chart with the axes properly labelled, error bars in 
place and everything else looking right. If you have to make a second plot of some other data, you 
could just go through the same steps outlined above. However, after you have made one plot, you 
can click once on it (this selects it) and then click on the Copy button on the Home tab. Next click 
on an empty cell and hit the paste button. This creates a copy of your plot. Of course it is plotting 
the same thing as your first plot, but it is easy to change what is being plotted. Click once on one 
of the data points and EXCEL will highlight the cells that are being plotted by drawing a cyan box 
(x-coordinates) or blue box (y-coordinates) around them. To change what is being plotted on the 
x-axis, just move your mouse over the border of the cyan box, click and hold, and then move your 
mouse until it is over the x-coordinates for the plot that you would like to create - the cyan box 
will follow - release the button when the box is over the coordinates you want to plot. You can 
expand or shrink the box by clicking on the corners.   
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13 - Adding Graphics to a Plot 
 Charts in EXCEL are created with a uniform white or gray background. If you have a file 
with a photograph or image, Excel can plot on top of it by changing the chart background. To do 
this, right-click on an open part of the plot - you need to click inside the area of the plot and avoid 
data points and grid lines. A window will open and you need to click on Format Plot Area - if 
you don’t see it, then you probably clicked outside the plot area or clicked on a gird line or data 
point and you just need to try clicking on another location in your plot. After you click on Format 
Plot Area, the Format Plot Area window will open. Select Fill, then select Picture or Texture Fill 
and finally select From File. A browsing window will open and you can now locate your image 
file that you want to use as the chart background.  
 
14 - Significant Figures 
 EXCEL does not automatically keep track of significant figures. This is a serious 
shortcoming in science and engineering. However, you can manually format cells to display the 
desired number of digits after the decimal point. To do this, click on the cell, then click on the 
Home tab. Find the Number section of the menu (see Figure 2) and click on the buttons for 
increasing or decreasing the number of digits displayed - each click on the button changes the 
number of digits displayed by 1. Other options in the number section of the menu allow you to 
change the number format to scientific notation, percentage, date, or other common formats. If you 
need to set the number of digits displayed in front of the decimal point, you have to switch to 
scientific notation by going to the pull-down tab in the Number section. 
 

 
Figure 2. Buttons for changing the number of digits displayed in a cell.   
 
 
15 - Fitting to Data  -  Least Square Fits to a Straight Line 
 There are several ways that you can use EXCEL to fit data to a straight line.  
 Suppose you have some data in the form of x and y-coordinates that you want to fit to a 
straight line. For example, suppose you have x-coordinates 1, 2, ...., 20 in cells H2 to H21 and  y-
coordinates 3, 5, 7, ...., 41 in cells I2 to I21.  EXCEL has built-in functions that can determine the 
slope and intercept of the straight line that is the best least-square fit to the data. To determine the 
slope of the best least-square fit line, go to an empty cell, and enter =SLOPE(I2:I21,H2:H21). Note 
that first range of cells I2:I21 is for the y-values and the second range H2:H21 is for the x-values. 
If you put the x-range first and the y-range second, you will get the wrong slope. To determine the 
intercept of the best fit line, go to another empty cell enter the formula 
=INTERCEPT(I2:I21,H2:H21). You can now use these slope and intercept values to calculate the 
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best fit y value for any given x value. 
 A second way to do a least-square fit of some data to a straight line is to click on the Data 
menu tab on the top of the spreadsheet, then click on Data Analysis (it’s on the far right side), 
select Regression and fill in the pop-up menu.   
 If you have a plot of your data, then there is a third way to do a least-square fit of a straight 
line to your data by adding a trendline. To add a trendline, go to your plot and right-click on one 
of your data points. Then select Add Trendline from the pop-up menu. The Format Trendline 
window will open and you can now select linear to put a straight line through your data. You will 
also want to select the Display Equation on Chart option, which will then give you the equation 
of the best fit line.  
 Note that these three least-squares fits will give you exactly the same answer, but that does 
not necessarily mean the fits are meaningful. You need to exercise caution when it comes to fitting 
data and there are many subtleties. EXCEL can fit a straight line to any data, whether or not it 
looks anything like a straight line. What EXCEL cannot do is tell you whether the fit is good or 
whether it is reasonable to try to fit the data to a straight line. In fact, a least-square fit may not 
even be the best straight line fit to your data and EXCEL will not tell you if there is a better fit. To 
answer such questions, you need to use a more powerful fitting technique such as χ2-fitting (chi-
square fitting). See Section 9 below for how to do a χ2-fit and Appendix A for a discussion of the 
differences between least-square fitting and χ2-fitting and how to decide if a fit is good.   
 
16 - Macros  
 An EXCEL Macro is a program that Excel can run in the background. Macros can greatly 
extend the power of EXCEL by automating complex tasks, creating new functions that don’t exist 
in EXCEL’s standard library of functions, or handling a wide variety of data collection and 
manipulation tasks. In Physics 121, we provide macros in some experiments for collecting data or 
handling some particularly difficult, sophisticated or time-consuming parts of the analysis. 
 While you won’t need to create a macro, you will need to know how to run them. To run a 
macro, you first need to get a spreadsheet template with the macro in it. For each experiment, the 
macros that you will need are included in the spreadsheet for that experiment. After you open the 
template, EXCEL may warn you that macros are present and it has disabled them - this is a security 
precaution and you should never enable macros on a spreadsheet from an unknown source since 
they can contain viruses. If you get this warning on a Physics 121 template, you will to click enable 
macros or else the macro will not run. 
 Before running a macro, you will need to enter any data that the macro will need - this 
depends on the macro and there will be explicit instructions in the lab write-up for each macro.  
 There are two ways that you can run a macro. In most of the spreadsheets we have added 
buttons to the spreadsheet that start the macro - just click on the button and the macro will 
automatically respond. The other way to run a macro is to click on the view tab, and then go to the 
far right end of the menu bar and click on the macros icon. A window will open with a list of all 
the macros that are available to that spreadsheet. Just select from the list the macro that you want 
and then click on the run button. If you don’t see the macro that you want on the list, it means 
your spreadsheet does not have that macro and you have downloaded the wrong template.  
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VII. In-the-Lab EXCEL Exercise  
Get Started 

Step 1 - On the lab computer’s desktop, find the folder called Lab Templates and open the 
EXCEL template called Phys 121 Lab 1 template. Do not use any other spreadsheet or 
a copy of a template from someone else - we keep track. 

Step 2 - If you get a warning that macros have been disabled, click on “enable macros”.  
Step 3 - Your spreadsheet should look similar to Figure 3 with a table of simulated data and 

some highlighted cells, but without the plots and some of the other areas filled in. The 
spreadsheet shown in Figure 3 is from an early prototype and the colors and layout may 
be somewhat different in the final version you will get. Cells that are highlighted beige 
or light brown need to have answers filled in. The column with times t is meant to 
indicate when a measurement was made on the speed of a cart, the next column shows 
the corresponding measured speed v of the cart, and the next column shows the 
uncertainty ∆v in each measurement of v.   

Step 4 - Enter your name, your section number and the date in cells B4, B6 and B7. If you 
have a lab partner, enter their name into the designated cell (if you do not have a lab 
partner, you will need to type “none” or “NA” into this cell). The cells change from 
beige to yellow after you fill them in. The templates have been set up so that the usual 
EXCEL save button is disabled. Instead, to save the file, you must have entered your 
name, your lab partner’s name (or “none” if you do not have a lab partner) you’re 
your section number into the spreadsheet in the designated area and then click on the 
gray save button in the body of the spreadsheet. The template won’t let you exit from 
EXCEL until after you have saved. 

 
 

 
Figure 3. Prototype 
Spreadsheet for Lab 1. 
The upper plot has blue 
points showing v versus 
t with error bars and a 
red line for the best fit 
line. The lower chart 
shows a plot of the 
kinetic energy E versus 
time t (blue points) and 
the black curve is a 
polynomial fit 
(quadratic fit) to the 
blue points. Notice that 
the numbers in the table 
in columns E and F have 
been formatted to 
display two digits after 
the decimal point. 
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Plotting 
Step 5 - Make a scatter plot of the speed v versus the time t. (discussed in section 9 above)  
Step 6 - Label the x and y axes of your plot. The x axis should be labelled “t (s)” and the y-

axis should be labelled “v (m/s)”. (discussed in section 11 above)   
Step 7 - Add error bars to your plot using the uncertainties ∆v given in cells D18 to D28.  

(discussed in section 11 above)   
 
Linear fit 

Step 8 - In cells C32 and C34 calculate the slope and intercept of the v versus t data - make 
sure you treat the times as x-coordinates and the speeds as y-coordinates. (discussed in 
section 15 above)  

Step 9 - Go to column E and use the slope and intercept values you just found to compute 
the best fit speed at each time. The best fit for the speed (which you should think of as 
the y-values) as a function of the time (which you should think of as the x-values) are 
found by using the formula for a line Y= mX + b.  Also remember that the slope m 
(which is in cell D32) and intercept b (which you put in cell D34) should be “fixed” 
with $ signs in your formula so they don’t change when you copy the formula. 

 
Modifying a Plot 

Step 10 - Add a curve showing a plot of the best fit speed versus time to the same graph as 
the v versus t data. To do this, try right-clicking on the chart and then click on select 
data and then click on add data. (discussed in section 11 above)  

Step 11 - Figure out how to get the data to be plotted as blue points and the best fit to be 
plotted as a solid red line without points. Try right-clicking on a point in your plot, 
select Format Data Series and follow where it leads. (discussed in section 10) 

Step 12 - Add a title (“Speed”) to your chart. 
 

Working with Formulas and macros 
Step 13 - In cell F18, enter the formula for the kinetic energy of the object with the speed 

shown in cell D18. (Remember that kinetic energy is 1/2 mv2). Check that you have 
used a fixed cell location for the mass. Your formula in cell F18 should be                  
  =0.5*$C$13*C18^2 

Step 14 - Copy the formula in F18 to the range F19…F28  
Step 15 - Make a plot of the energy E versus time t. Add a chart title and label the axes. 
Step 16 - Add a polynomial fit to your plot of the E versus t data (just right click on a data 

point on your plot, select add trendline and then choose polynomial). Make sure you also 
select display equation on the plot. If you forgot to select display equation and already 
closed the trendline window, just double-click on the fit curve to reopen the window and 
you can select display equation. 

Step 17 - We have included a custom macro (discussed in section 16) in this template that does 
a fit to the E versus t data. This particular macro actually does all the work for you - it 
generates the uncertainty in E based on the uncertainty in v, fits to a quadratic dependence 
of enegy on the time, and displays a table of the results and best fit parameters. To run 
this macro, just try clicking on the “run χ2 button” in the spreadsheet.  

 
Finishing Up 

Step 18 - Check your spreadsheet to make sure that you have not missed any steps and have 
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no brown or beige cells that need to be filled in. Also check that there are no red 
feedback messages being displayed. If you see a red feedback message on your 
spreadsheet it means that you have done something wrong and need to fix it. The 
feedback system cannot detect all problems, so check your answers carefully. 

Step 19 - Save your spreadsheet! Note: The templates have been set up so that the usual 
EXCEL save button is disabled. Instead, to save the file, you must have entered your 
name, your lab partner’s name (or “none” if you do not have a lab partner) you’re 
your section number into the spreadsheet in the designated area (see step 1) and then 
click on the gray save button in the body of the spreadsheet. The template won’t let 
you exit from EXCEL until after you have saved. 

Step 20 - The saved spreadsheet will be put into the My Documents Folder on the desktop 
with a file name that includes your name. Check that it is there. 

Step 21 - Log onto ELMS Canvas, go to the Physics 121 assignments, and figure out how to 
download and submit a copy of your spreadsheet for Lab 1 before you leave the lab. 
You do not need to do a separate lab report for this experiment - just make sure both 
you and your lab partner each work through Part VIII and each of you submit your 
work. You should also save a copy of the spreadsheet on a memory stick or e-mail 
yourself a copy before you leave the lab. 

Step 22 - Do not turn off the lab computers - just close your spreadsheet and any other 
programs that you used 

Step 23 - Finally, make sure you get your lab partner’s name and his or her contact 
information and don’t forget to prepare for the next lab and submit your answers to the 
prelab questions for the next lab before they are due. 

 


